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Creating an Optimized Windows XP Digital Imaging System
By Tim Grey

An understanding of what affects system performance and what factors can best improve that
performance can be invaluable. In this document you’ll learn about the fundamental issues that
affect system performance for digital imaging on a computer running Microsoft® Windows® XP.
Even if you’re a digital imaging expert with a strong knowledge of computers, you’ll probably learn
some helpful tips in this document. It covers the full range of hardware for a computer dedicated
to digital imaging, as well as a discussion of key software issues for Windows XP and the software
you’ll be using to optimize your images. As a result, you’ll be prepared to configure an optimal
system that offers peak performance for digital imaging.

Digital imaging places significant demands on computer hardware and software, simply because
the tasks performed need to process significant amounts of data. A typical 6-megapixel digital
SLR camera produces images with pixel dimensions requiring 18 megabytes. If the photographer
takes advantage of RAW capture capabilities, resulting in a 16-bit file, that size doubles to 36 MB.
Resizing the image for a 20”x30” print results in a file of around 150 MB in 8-bit, or 300 MB in
16-bit.

For photographers who are either still shooting film or needing to digitize images from their
existing library of film captures, the numbers can be even larger. A typical 35mm film scanned at
4000 dpi in 8-bit will result in a file of around 55 MB, with a 16-bit scan producing about a
110 MB file.

Of course, many photographers utilize medium format film to maximize the detail they are able
to capture. The size of the file grows with the film. Scanning a 6x4.5 transparency at 4000 dpi
yields a file of nearly 200 MB in 8-bit, or 400 MB in 16-bit.

When these files are optimized with photo-editing software, values for millions of individual pixels
must be recalculated. This requires not only storage space for all those pixel values, but computing
power to actually crunch the numbers. When dealing with such a significant amount of data, small
details affecting overall performance issues can have a significant impact on the time required to
perform various tasks. These gains are especially notable for tasks that place a particularly high
demand on the system. For example, complicated filters are processor and memory intensive,
while file read and write operations call for improved data transfer performance.

Various tasks in a digital imaging workflow call upon different hardware and software components.
By improving overall performance in as many areas as possible you’ll ensure optimal overall
performance for these demanding tasks.
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Hardware
The hardware components of your computer system are doing
all the actual work of processing information, so it makes sense
that your choice of hardware is a key factor in the overall
performance of your digital imaging system. By making the right
choices when configuring a new computer or upgrading an existing
computer you will ensure optimal performance to meet the
demands of digital imaging.

One of the first considerations when deciding on a computer is
whether to get a standard desktop computer or an advanced
workstation computer. The advantages of a workstation include
greater expandability, support for multiple processors, higher
component quality, more robust RAID support, and certification
for third-party applications such as Adobe programs.

You’ll also need to decide which operating system will be included
on a new computer, or if you should upgrade an existing computer.
Windows XP Professional offers significant support for digital
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overall color gamut of the display being restricted. Furthermore, variable brightness settings are
often used based on whether the laptop is plugged into an outlet or operated from battery power,
further complicating the issue of being able to make an accurate assessment of your images on
a laptop display.

With all of their disadvantages, it is important to keep in mind that laptops also offer advantages,
particularly for photographers who spend considerable time traveling to photographic destinations.
A laptop provides a way to download images from your digital media cards, and then review those
images at their full resolution. You can also perform basic sorting of the images, and perform basic
optimization. With a CD or DVD burner, or other external storage device, you can also create a
backup copy of your images as you capture them.

In short, a laptop computer isn’t ideal for critical image optimization, but can be an invaluable
resource in the field. A laptop isn’t recommended as a desktop replacement, but still serves a
valuable role in the digital workflow.

Tablet PC Considerations
As more and more gadgets compete for space in your camera bag or studio, you may want to
consider a tablet PC as an alternative to a laptop. While it has the same limitations as a laptop
display, it offers the same capabilities in a more compact
and ergonomic package. In most respects a tablet PC can
be thought of as a laptop in a different case and with a
different user experience.

In addition to what many consider a more ergonomic user
experience, a tablet PC does offer other advantages beyond
a laptop computer. Adding to the user experience, the display
can be configured for portrait or landscape display. While
the images could easily be rotated to achieve a similar result,
the ability to rotate the on-screen display means that all
controls will also rotate. If you’ve ever picked up your laptop
and rotated it, you get the idea of how much easier a tablet
PC is in this regard, and how nice it is to have all interface
elements rotated along with the image.

Another advantage of the tablet PC relates to the more
robust support for drawing directly onto the display. By their
nature, tablet PCs are designed to make use of a pen that
allows you to draw directly on the display. Laptops can mimic
this behavior with special software, but it isn’t as elegant a
solution as using a tablet PC. With appropriate software, or even directly in Adobe Photoshop or
other photo-editing software, you can markup the image to indicate retouching or corrections
you’d like to apply later.

imaging applications over other versions of Windows, and includes features to help capture,
organize, edit, and share your digital photographs. Additional Windows XP Professional features
include support for multiple processors, more robust security and networking features, and Remote
Desktop support so you can access your computer from anywhere.

Desktop Versus Laptop
The first consideration when determining specifications for a new
computer is the “form factor” of that computer. In general, this involves
a decision between a desktop and laptop computer. Particularly for
those who tend to travel frequently, the portability of a laptop can
be very compelling. However, you’ll want to consider several factors
before making a decision.

In general, a laptop represents a compromise compared to a desktop
in terms of performance, expandability, and upgradeability. That
doesn’t mean a laptop can’t be used for digital imaging, but you’ll
want to be sure you understand the compromises involved when
making a decision.

Because of their requisite smaller size, laptops don’t offer the internal
space for additional components. Instead, you’ll need to utilize
components that connect via an external interface or that plug into
the PC Card slot. While many such components are available, you
don’t have nearly the flexibility as with a desktop computer. Desktop
computers, on the other hand, are generally able to support the
addition of several expansion cards as well as additional hard drives
and other components.

The smaller size and need for more modest power requirements of a laptop also means performance
compromises. Mobile versions of popular processors require less power, but also offer slower
performance. Smaller motherboards often mean a lower limit on the maximum amount of memory.
Less space also means smaller hard drive capacities.

Display issues also cause concerns for a laptop. In an effort to keep the overall price of laptops
reasonable, many manufacturers are forced to compromise on the quality of laptop displays.
Including an LCD display in a laptop that rivals the quality of a standard computer monitor can
be prohibitively expensive. In particular, laptops tend to have more significant issues that affect
their usefulness for critical image review and optimization. Many laptop displays have a relatively
narrow viewing angle, causing shifts in tonal and color appearance with slight changes in head
position. If you aren’t looking at the display straight on, you may not be getting an accurate look
at the image. The contrast ratio for these displays tends to be lower, resulting in a lower range
of tonal values that can be displayed. It also may not be able to produce bright whites and dark
blacks. Color fidelity can also suffer, with colors not appearing as vibrant as they should, and the
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Memory
Random access memory (RAM) is a valuable commodity in a computer used for digital imaging.
Because such work involves processing a tremendous amount of information, significant memory
is required to perform those tasks quickly. In fact, adding memory to a system is arguably the most
cost-effective way to improve overall system performance. If you don’t have enough RAM,
performance will suffer.

How Much
Knowing you need a lot of RAM is one thing, but figuring out how much is actually enough can
be something different. A general rule of thumb is that you should have at least ten times as much
RAM as the size image files you typically work with. That would imply that photographers working
with 4000 dpi scans in 8-bit from 35 mm transparencies would call for about 512 MB of RAM, since
the files would be around 55 MB in size. Photographers working with medium format scans, high-
bit images, or composite images would want to consider 1 GB of RAM.

However, this rule of thumb revolves around bare minimum performance
expectations. In other words, if you follow this guideline for RAM, you
probably won’t be disappointed with performance, but you also won’t
be taking full advantage of the opportunity to maximize performance.

The best strategy to ensure you have more than enough RAM is to
make sure you have more than you’ll ever need. Adobe Photoshop
is able to address up to 2 GB of RAM, and you’ll also want to be sure
the operating system has adequate RAM for other operations. For
maximum performance and the comfort that you have as much (or
more) RAM as your most intensive applications will ever need, configuring
a system with 3 GB to 4 GB (or more) of RAM is recommended.

What Kind
There are more RAM specifications out there than you can probably
imagine, each with their own benefits. The various architectures for
RAM provide varying performance capabilities, though in many cases
the differences are relatively minor, and wouldn’t be noticed by the
user. The most important consideration when it comes to RAM is most
certainly how much you have. However, you should consider the type
of RAM as well to ensure the fastest performance possible.

While new RAM architectures will certainly provide even better solutions in the near future, the
current best option is arguably DDR2 SDRAM (Double Data Rate Synchronous Dynamic Random
Access Memory). The “synchronous” indicates that the RAM is synchronized with the clock speed
of the processor, which generally improves the number of instructions that can be performed.

Double data rate refers to the fact that the memory cycles
at both the “peak” and “valley” of the clock signal, so that
it is able to achieve speeds that are about double what
would otherwise be achieved.

Another consideration for RAM performance is the bus
speed, which determines how quickly data can be moved
to and from the RAM itself. It is best to select RAM with
the fastest speed possible in this respect.

As new memory technologies develop, it is a good idea
to review recent sources of information such as computer
magazines and online Web sites devoted to these technical
topics so you’ll know which option represents the fastest
performance for your system.

Hard Drive
Many users who look for the very best performance from
a computer tend to overlook the importance of hard
drive performance. The hard drive is often seen as a simple storage device, used for long-term
storage of image files. It is often reasoned that additional time required to open or save files isn’t
a major concern, so hard drive specifications are overlooked.

The truth is that hard drive performance can have a
significant impact on overall system performance. Besides
reading and writing large files, the hard drive is also used
heavily when applications are loaded, as well as for virtual
memory or scratch space by the operating system and
various applications. While hard drive performance isn’t
nearly as important as having adequate high-performance
RAM, a fast hard drive configuration is an important factor
in an optimized system for digital imaging.

Interface Options
While SCSI (small computer system interface) used to
be the standard for high-speed hard drive interfaces, the
performance improvements of other technologies (not
to mention the sometimes challenging aspects of
managing SCSI devices) have made other options more
attractive. In particular, the latest Serial ATA interface offers
excellent performance that rivals (or exceeds) most SCSI specifications. Both options remain
excellent choices for high-speed data throughput for digital imaging.
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For most applications, Serial ATA will be easier to manage while
still offering the best throughput speeds available. SCSI tends
to only be used on workstation or server computers (as opposed
to desktop models), but still offers excellent performance.

Performance Specifications
The specifications of the hard drive itself are a key factor in overall
data throughput capabilities. There are several factors to consider
when evaluating overall hard drive performance.

The spin rate, measure in RPM (revolutions per minute) is one
of the most commonly touted specifications, and is an important
factor in overall hard drive performance. Most drives available
will offer 5400, 7200, or 10,000 RPM. The latest drives offer 15,000
RPM, and these will gradually become more common. This factor
doesn’t by itself determine overall data throughput speeds, but
it is an important consideration and it is best to get a drive with
the fastest rotational speed possible.

Another factor that is often shown for hard drives is the seek
time, measured in milliseconds. This is the average time it takes
for the hard drive to move the disk platter and heads into position
to read a specific piece of data. Average seek times under 10
milliseconds would be considered good.

The most important consideration in actual performance is the
sustained data transfer rate, as this is the most accurate measure
of how quickly data can actually be written to (or read from) the
drive. Most current drives are capable of reading or writing data

at a sustained rate of around
150 MB per second, and
faster is always better.

Capacity
When it comes to hard drive
capacity, for most digital
imaging applications more
is always better. The most
common drive sizes at this
writing are around 250 GB,
but 400 GB drives are also
available, and with time
even higher capacities will
.

be possible. For a typical photographer a hard drive with 250 GB capacity may last for many years
at typical rates of acquiring new images. However, when creating multi-layered image files, possible
in 16-bit mode, file sizes can grow to hundreds of megabytes each quite easily. It is always best
to have more than adequate hard drive space both for image storage and for use as virtual
memory and Adobe Photoshop scratch disk space. Fortunately, hard drive prices on a per gigabyte
basis have gotten to be very low (around one dollar per gigabyte for most drives), so it is easy
to justify getting the largest hard drive possible, and possibly more than one drive in the system
to further supplement storage availability

Internal Versus External
External hard drives offer the advantage of data portability, which allows you to easily transfer very
large files to a different location when necessary for image processing (such as when submitting
large images to a printer) or for offsite backup. However, external drives offer a performance
disadvantage compared to internal hard drives. This is less of an issue for the latest FireWire 800
external hard drives, but it is still recommended that you treat external hard drives as supplemental
storage or backup devices, while using an internal hard drive for storage of images you are actively
working on and for use as virtual memory or Adobe Photoshop scratch disk space.

RAID
RAID (Redundant Array of Independent Disks) is a way to group multiple drives together to provide
a performance and possibly data redundancy advantage. While there are a number of levels of RAID
implementation, there are two major levels you may want to consider.

RAID-0 doesn’t offer any data redundancy at all, but can provide a performance advantage. It
achieves faster read and write performance by treating two hard drives as though they were one,
but spreading the data across two drives with a processed known as striping. In this process, a file
can be written to disk twice as fast because every other cluster is being written to a different drive
(for example, odd clusters on the first drive and even clusters on the second drive). Because both
drives can be written to at the same time, overall performance can improve. This is an excellent way
to achieve faster data transfer rates and faster application loading times.

RAID-5 offers the same advantage of striping, but adds fault tolerance so that if one of the two
drives fails, the data can still be recovered. In fact, if a drive does fail it wouldn’t cause any interruption
in data access (though system maintenance would obviously then be in order). RAID-5 is an excellent
choice to include both performance benefits and the comfort of data redundancy, although having
such a system should not replace frequent backing up of your data.

RAID can be included as a specification for your computer when you order it, which is a convenient
way to add this capability. You can also add RAID support by installing a RAID controller card in
conjunction with the hard drives you’ll use in the RAID configuration. This will require that the new
(or existing) drives be reformatted, so you’ll want to ensure you backup your data before beginning
the process.

Creating an Optimized Windows XP
Digital Imaging System



98

File System
Hard drives must be formatted with a particular file system before data can be written to them.
The process of formatting prepares the drive to receive data and establishes the “table of contents”
for the drive. This table of contents is referred to as the File Allocation Table (FAT), which is where
the term FAT32 (and FAT16 before it) came from. FAT32 is a 32-bit version of the FAT file system
that has been around for many years.

While FAT32 does provide backward compatibility with older operating systems, there are a number
of advantages to using the newer NTFS for your hard drives.

One of the major advantages of NTFS (and the feature that tends to cause users to make the
conversion from FAT32) is support for larger hard drive volumes. Besides supporting larger capacity
hard drives than FAT32, NTFS also offers more efficient cluster usage, so that files are stored more
efficiently with less waste of disk space. The NTFS files system uses transaction logging and recovery
techniques that enable the operating system to restore files to their original state after a system
failure or other problem. Bad sectors on the hard drive are also automatically re-mapped, so that
bad sectors can’t be used for data storage. Built-in security features for NTFS also make it more
appropriate for networked environments when other users may have access to files on your system.
In short, NTFS is more stable and robust, and is highly recommended as the file system of choice
for digital imaging.

Processor
While RAM and the hard drive handle the major chores of moving data around, the processor is
actually handling the huge number of calculations that are involved with all tasks from the mundane
to the most advanced digital imaging workflow. It is therefore a critical piece of overall
system performance.

Fortunately, it has become relatively easy to select a processor for a digital imaging computer. As
the Intel processors have become the standard for Windows-based computers, they generally
offer the advantage of maximum compatibility with Windows applications. AMD (Advanced Micro
Devices) processors have also maintained excellent compatibility with the Intel standards, and offer
excellent performance. This leaves two major families of processors to consider for digital
imaging applications.

Intel Processors
Within the family of Intel processors, there are two basic choices available when it comes to optimal
performance: Pentium 4 and Xeon. Both offer excellent performance for today’s demanding
applications, but the Xeon processor is optimized for maximum processing power as well as
multiple processors for even greater performance. Other processors in the Intel family include
mobile versions of the Pentium 4, Celeron, and Centrino. All of these perform well, but represent
a compromise in performance to either meet the needs of mobile computing (Pentium 4 Mobile
and Centrino) or offer a lower price point (Celeron).

For digital imaging applications it is therefore best to utilize the Pentium 4 or Xeon processors
within the Intel family.

The basic choice between the two key processor options from Intel usually comes down to budget.
The Pentium 4 option still offers excellent performance, but at a lower price than the Xeon processor,
especially when you consider that Xeon processors are usually only offered in the higher-end
workstation computers and often in dual-processor arrangements. For most users a high-end
Pentium 4 will provide more than adequate performance. However, if you’re hungry for more
power you can certainly achieve an advantage by opting for a dual-processor Xeon configuration.

AMD Processors
Within the family of AMD processors the Athlon group includes those processors that will offer
the best performance for digital imaging applications. The Athlon XP could be thought of as the
“baseline” processor for use with digital imaging, and it offers excellent performance.

The Athlon XP line of processors are 32-bit, which matches the processing architecture of the
primary Intel processors. The Athlon XP is therefore an appropriate alternative to the Pentium 4
processor. AMD also offers a lineup of 64-bit processors. These processors support the current
32-bit applications and operating systems, but also offer support for future software upgrades
that will take advantage of the performance benefits of 64-bit processing. In addition, the AMD64
product lines include significant architectural enhancements such as an integrated memory
controller and Hypertransport for fast memory access. Selecting a processor in the Athlon 64 or
Athlon 64 FX family will therefore ensure optimal performance with support for the 64-bit operating
system platform that is being developed now by Microsoft. Both the Athlon 64 and Athlon 64 FX
processors offer exceptional processing performance, with the FX processor adding features to
improve the experience with high-end gaming and full-motion video.

To take advantage of a multiple processor configuration, AMD offers the Opteron line of processors.
Normally targeted at the server and workstation market, a dual-processor Opteron configuration
offers power for processor-intensive applications such as the demands of digital imaging. In addition
to supporting multiple processors, the Opteron line also supports both 32-bit and 64-bit instruction
sets. This will allow you to take advantage of the improved performance of 64-bit computing in
future software

64-Bit Computing
The latest Intel Pentium 4, Intel Xeon, AMD Athlon 64 and AMD Opteron processors support a
64-bit instruction set, which allows the processor to handle more data for each clock cycle. The
processor can therefore operate more efficiently, which translates into faster overall performance.
The 64-bit version of Windows XP supports up to 32GB of RAM and multiple processors, meeting
the demands of processor- and memory-intensive applications for digital imaging.

The move toward 64-bit operating system and applications provides greater performance, and
is a natural fit for digital imaging. As more applications support this platform, it will be even more
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important to have a processor capable of 64-bit instructions, and upgrading to Windows XP 64-
bit Edition.

Choosing the Processor
Once you’ve decided on a model of processor, the only major decision that remains is the clock
speed. This decision is really a matter of compromising between performance and price. Because
the latest and greatest processor will generally carry a higher price tag than the actual performance
advantage offered would normally indicate, you may want to consider saving money for a slightly
slower (though still very fast) processor. If performance is more important than budget, you can
obviously choose the fastest available processor at the time you make your purchase.

When comparing processor clock speeds between Intel and AMD processors, keep in mind that
the numbers do not compare evenly. The architecture of the processor itself has a significant effect
on performance, so that what would appear to be a slower processor based on clock speed may
actually be comparable or even faster than the processor with the higher clock speed. When
comparing processors within the same family from the same manufacturer you can use clock
speed as an indicator of relative performance, but across different processor families this may not
be an accurate measure.

In the case of the Intel Xeon and AMD Opteron processor, you can also opt for dual processors
for even greater performance. This is a relatively modest gain for most applications, but will provide
faster processing for advanced tasks such as complicated adjustments or filter applications in
Adobe Photoshop. The architectural design of the AMD Opteron line allows twice as much memory
in a dual configuration and twice the aggregate memory bandwidth which means increases in
performance as well. For the Pentium 4 line of processors the HyperThreading technology (which
is also supported by their Xeon line of processors) creates a similar advantage (though not one
with as significant a performance boost) by making the processor appear as though it were two
processors to the system, making it able to process parallel tasks more efficiently.

Other factors that affect processor performance, such as bus speed and cache size, are also
important considerations.  Traditionally, the processors available from computer manufacturers
have had the same specifications, however AMD64 products have integrated the memory controller
into the processor so that it runs at the same speed as the processor and scales up with each
processor upgrade. Clock speed is more frequently updated than the other parameters. However,
if there is an option, you should opt for the fastest bus speed and largest cache possible.

Display Adapter
When you think of high performance in a display adapter, the types of uses that probably enter
your mind are full-motion video editing and the latest high-end games. While these types of use
certainly demand the very best in display adapter technology, the display settings used for advanced
digital imaging also require a significant amount of horsepower.

Consider that a screen resolution of 1600x1200 with 32-bit color represents about 8 MB of data
for the image displayed on the monitor at a given moment. With a dual-monitor setup, this could
be doubled to 16 MB. When you consider that the screen needs to refresh at a rate of around
85 cycles per second (Hertz), you can get a better sense of the considerable horsepower required
to drive the display. Most current display adapters provide adequate performance for this typeof
use, but reviewing specifications for display adapters will give you a better sense of whether a
particular model will adequately meet your needs.

Processor
The processor on a display adapter is very similar in concept to the main processor for your
computer, except that this processor’s sole job is to process the video signal that drives the display
on your monitor. The performance of this processor determines how fast the display can be
rendered and updated. In the case of still-image editing, the rendering speed affects how quickly
the display can be updated when significant changes need to be applied to an image in real time.
The performance is critical for full-motion video and high-end games that require particularly fast
rendering, but it is also important for still-image editing on a high-resolution display.

When choosing a display adapter, chances are the particular specifications for the processor on
the adapter won’t be listed. Instead, the processor model will typically be indicated. For example,
the ATI Radeon line of cards utilizes the Radeon processor technology for exceptional display
performance. To ensure the best possible performance, it is a good idea to read reviews aimed
at high-end gaming to ensure you’ll have more than adequate video performance for even the
most demanding situations at the highest resolutions and color depths.

VRAM
The key consideration for video RAM (VRAM) is how much, and the safest answer is “as much as
you can get”. While you could most certainly achieve satisfactory performance for digital imaging
with a card offering around 32 MB of RAM, having more will ensure that even the fastest rendering
and dynamic display requirements will easily be met by your display adapter. For optimal digital
imaging performance I recommend a display adapter with 128 MB or more of VRAM.

Multiple Monitor Support
Just as you can work more efficiently with a larger desk to spread out your documents and tools,
so can having more than one monitor provide a more efficient digital workflow. In particular, having
two monitors connected to your computer to extend the virtual desktop allows you to use the
primary monitor for just the image you’re working on, while using the second monitor for tool
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palettes, folder views showing thumbnails of the images
you’re working on, and other tools. This provides an
uncluttered and efficient way to work on your images.

Windows XP provides support for multiple monitors right
out of the box. In fact, you can add as many display adapters
to your system as you have slots available on the motherboard,
and connect a monitor to each of them. Of course, this can
quickly turn into a situation of diminishing returns, as there
are only so many things you want to see on a monitor at a
given time, and each of those monitors will consume some
space on your desk. For most digital imaging applications
two monitors will be more than adequate.

Besides adding a second display adapter to your computer,
many display adapters will support two monitors at once by
having dual outputs on the card. Most of these cards offer
one digital (DVI) and one analog (HD-15) connection. Such
cards were originally intended to provide the option to
connect either a digital (LCD) or analog (CRT) display to your
card, but updates enable using both at the same time for
dual-monitor support. Adapters can be used to utilize such
cards for two analog or two digital displays if necessary.

If you’re using LCD displays, you may want to look for a
display adapter that offers two digital (DVI) outputs so both
displays can utilize a digital signal that doesn’t get converted
to analog and back. Utilizing two digital outputs helps ensure
color fidelity by maintaining that digital signal through the
whole pipeline. Cards such as the Matrox Millennium series
offer dual-digital output support.

Monitor
LCD versus CRT
Selecting an appropriate monitor for your digital darkroom
is an important first step to a color-managed workflow that
ensures accurate color through the full image-optimization
process from monitor to print. The first decision when buying
a new monitor is whether you'll go with a "standard" CRT
(cathode ray tube) monitor, or a "flat screen" LCD (liquid
crystal display) monitor.

Comparing CRT and LCD monitors is like the proverbial apples
to oranges comparison. Both types of monitors do the same
basic job, but they have different advantages and disadvantages.
When deciding which type of display to get, you need to consider
the basic specifications and relative merits of each of each, and
then determine which is right for you.

The actual process for most photographers these days tends
to be trying to justify the purchase of a space-saving and "cool"
looking LCD display. Let's take a look at the basic specifications
to see what the advantages and disadvantages are for each
monitor type. Try not to focus on how cool it would be to have
a skinny LCD monitor on your desk. Instead, consider the various
compromises involved when choosing between a CRT and LCD
monitor.

The simple fact is that CRT monitors still have an advantage
over LCD monitors in terms of general specifications. The very
best monitors are still CRT monitors. However, some excellent
LCD monitors are also available. You just need to be a bit more
careful to ensure that a particular LCD monitor will provide you
with the quality you are seeking.

Regardless of whether you purchase a CRT or LCD monitor, be
sure you're getting the best display that fits your budget. Later
in this chapter, I'll discuss specifications to look for in both CRT
and LCD monitors, so you can make an informed decision.

You can certainly find an LCD
monitor that will provide an
excellent display for optimizing
your images, but be prepared
to pay considerably more than
you would for an equivalent
CRT monitor.

Here are the basic
specifications to see what the
advantages and disadvantages
are for the best models of each
monitor type:
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Brightness

Contrast Ratio

Viewing Angle

Color Fidelity

Refresh Rate

Resolution Options

Focus

Power Consumption

Size and Weight

Glare

Uniform Brightness

Geometry

Very Good

Excellent

Excellent

Excellent

Excellent

Excellent

Very Good

Good

Good

Good

Very Good

Very Good

Excellent

Very Good

Good to Very Good

Very Good

Very Good

Very Good

Excellent

Excellent

Excellent

Very Good

Excellent

Excellent

CRT LCD
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Because of the flexibility of CRT monitors, you don't need to concern yourself with a specific
resolution setting for these displays. Also, most CRT monitors currently on the market support
very high resolutions. In fact, many of them support resolutions that are so high they can be hard
on the eyes due to the smaller size of objects on the screen. The optimal resolution setting will
vary based on the monitor size. For monitors up to about 17”, the maximum resolution most users
will want to use is 1024x768. For larger displays up to about 20”, a resolution of 1280x1024 is
generally preferred. For displays larger than 20”, a resolution of 1600x1200 or higher could be
used effectively.

Refresh Rate - Flicker in a display can be incredibly annoying. Fortunately, most current CRT
displays have an adequate refresh rate to avoid flicker in most—if not all—supported resolutions.
Look for a monitor that supports a refresh rate above 85Hz for the resolution you plan to use for
the display.

Flatness - Not to be confused with LCD displays, many CRT monitors are promoted as being
"flat-screen”. This term refers to the lack of curvature in the glass at the front of the monitor. Most
monitors use a tube with a curved front surface, which can add to the distortion in the image
being displayed. A flat-screen CRT monitor produces a more geometrically accurate display, which
is much more pleasing to the eye. It is also less prone to glare from light sources other than those
directly in front of the monitor.

Color Controls - To get the best results when calibrating your CRT display, it is best if the
monitor provides the ability to adjust the color. This ability is generally offered as a gain control
for each of the three (red, green, and blue) electron guns that are used to produce the image
you see.

This adjustment capability allows you to fine-tune the monitor display before creating a monitor
profile, so the monitor is as accurate as possible and, therefore, requires only minor adjustments
through the profile. This isn't a critical option, but it's a valuable one. Fortunately, many current
monitors offer this capability, so it shouldn't be difficult to finding a model that includes color
controls and meets your other requirements shouldn't be difficult.

LCD Monitor Specifications
While LCD monitors have some disadvantages, such as reduced color saturation and a loss of
detail in shadow areas, a good LCD display can be used very effectively in the digital darkroom.
Buying an LCD monitor requires that you understand the features that are important, and that
you know what to look for.

Brightness - LCD monitors actually tend to be much brighter than you need them to be,
requiring some adjustment in the calibration process. Brightness is generally measured in candelas
per square meter (cd/m2), and most LCD monitors range in brightness from about 170 to 300
cd/m2. In general, you'll want to get a display that has a brightness of about 250 cd/m2 or higher.

CRT Monitor Specifications
If you want to choose a CRT monitor to achieve optimal display
quality—at least until LCD monitors achieve better quality at a
lower price—it is important to make sure you select a CRT that
will meet your needs. While CRT monitors in general have some
advantages over LCD monitors for photographers working in the
digital darkroom, that doesn't mean you can ignore the features
of the CRT you buy.

Fortunately, CRT monitors aren't exactly new technology, so there
are a wide variety of excellent displays at reasonable prices. In fact,
a relatively high percentage of the monitors available are more
than adequate for use for digital imaging. You will want to consider
some key features when considering a new CRT monitor.

Size - With CRT displays, you don't have to worry too much about
having a monitor that is too big. Of course, available desk space
may contradict this statement, but image quality generally won't
suffer too much when you use a larger CRT display. LCD monitors
aren't quite as flexible, as will be explained in a later section. Bigger
is usually better when it comes to CRT monitors. Of course, if space
is tight and you'll be sitting close to the display, you might want
to cut back a little on the size.

In general, I consider a 17” monitor to be the absolute minimum
for digital imaging use, but smaller than I’d recommend. It is a
workable size, but it will tend to feel a bit cramped for digital
imaging. A 19” display is a good compromise between size and
price, and it is a good starting point. If you have the desk space
and budget, a 21” monitor will give you much more room to
spread out.

Dot Pitch - The dot pitch is a measure of the distance between
pixels of the same color (remember that each pixel is comprised
of three sub-pixels of red, green, and blue). The dot pitch is
measured in millimeters, and a lower number indicates a crisper
display. In general, you'll want to look for a CRT monitor with a
dot pitch below about 0.25mm.

Resolution Support - CRT monitors are more flexible when
it comes to displaying at different resolutions, and they don't
require that an "optimal" resolution setting be used for the best
image quality as are required with LCD monitors (which will be
discussed later).

Creating an Optimized Windows XP
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Pixel Response Time - Pixel response time relates to the
speed at which the monitor display can be updated. This isn't a
major issue for still images that are displayed on an LCD monitor.
However, just because you aren't editing full-motion video doesn't
mean you don't have to be concerned with pixel response time.
For example, if you move your mouse pointer quickly across the
screen, the pixel response time will determine whether the mouse
will remain clearly visible as you move it.

The faster the pixel response time, the more quickly the display
can be updated. That means your mouse is less likely to disappear
as you move it across the display, and full-motion video will remain
fluid rather than choppy.

Many manufacturers neglect to include pixel response time in their
specifications. When you are able to obtain the specification, look
for pixel response time of 30 ms (milliseconds) or lower.

Display Size - Bigger isn't necessarily better when purchasing
an LCD display. While it gives you a larger display area, it a bigger
monitor display can actually reduce image quality. Running at the
same resolution, a smaller monitor will use smaller pixels, which
results in a smoother display of higher quality. If you run the same
resolution on a larger monitor, the larger pixels will result in a
display that is coarser and more pixilated. Keep in mind that any
given LCD display will have an optimal resolution setting for that
display, which is the setting that will afford the best quality.

Viewing Angle - Viewing angle is one of the most important
factors to consider when purchasing an LCD monitor. Fortunately,
most recent LCD monitors have greatly improved in this regard.
With a low viewing angle, the relative brightness and color of the
display will vary considerably with slight changes in your position
relative to the display. When buying an LCD monitor, look for a
display with a viewing angle of 120-degrees, and ideally above
160-degrees.

Because the LCD displays used on laptop computers tend to be
of lower quality than the best LCD monitors, it is generally best to
avoid doing any critical imaging work on your laptop display.

Resolution - In general, you will probably want a monitor that supports as high a resolution
as possible so you can see more of your image at once on the display. However, it is important
to match maximum resolution to an appropriate monitor size for LCD monitors. The display on
an LCD monitor will look best at the native resolution for that display. If you get an LCD monitor
with a very high native resolution and then set it for a lower resolution, the display won't be of
optimal quality.

I usually recommend a native resolution of 1024x768 for monitors up to about 17”. For displays
over 17” to 20” a resolution of 1280x1024 or more is generally best. For displays above 20”, a
resolution of 1600x1200 may be best, provided you don't have a difficult time reading small text.
Of course, you can also increase the magnification of text to help overcome this problem.

Unfortunately, in many cases the only source for information about the native resolution of a
display is the documentation included with the LCD monitor. Some monitors will present a message
to let you know when you have set the resolution to a value other than the native resolution, but
this isn’t universal. Check the documentation or product brochures before making a decision on
a particular monitor, ensuring that the native resolution matches the resolution you prefer to work
with if at all possible.

Contrast Ratio - The contrast ratio defines the range of tones from pure black to pure white
that can be displayed. The higher the contrast ratio, the more tones the monitor can display, and
the smoother the gradations in tone and color. With a low contrast ratio, detail in the shadows
will tend to block up so that you can't see all the detail that is actually present in the image file.
A contrast ration of 350:1 would be considered a minimum. Most current LCD displays have a
contrast ratio of 400:1. The highest is about 500:1, at this writing. This will continue to improve
as LCD technology advances. In the meantime, look for the highest contrast ratio possible.

Keep in mind there isn’t an established standard for measuring contrast ratio, and many excellent
monitors have a lower contrast ratio rating than their image quality and tonal range would
otherwise indicate. A good example of this is the Sony PremierePro 23” LCD display. The contrast
ratio is listed as 350:1, but the display provides excellent tonal range that is better than you would
expect from a monitor with such a rating.

Pixel Pitch - With CRT monitors, dot pitch is an important measure of overall image quality
and crispness. With LCD displays, this is generally referred to as pixel pitch. It is important, though
in a slightly less direct way.

The most important factors that affect the clarity and smoothness of an LCD display are the native
resolution relative to the display size. Pixel pitch is a way to express this, but simply comparing
pixel pitch isn't the most accurate way to determine the overall quality of the display. Still, it is an
issue to consider, and you'll want to look for an LCD monitor with a pixel pitch of under
about 0.28mm.

Creating an Optimized Windows XP
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monitor to achieve a more accurate display. While using Adobe Gamma is better than using
nothing at all, if you want the best results you should purchase a monitor calibration package that
includes a colorimeter for measuring values from your monitor, rather than trusting your eyes
while working with Adobe Gamma.

If you’ve previously run Adobe Gamma, it will have added itself to the Startup group in Windows,
causing it to run each time the computer is started. This can interfere with the results achieved
with a monitor calibration package, so you’ll need to disable Adobe Gamma. To be sure it isn’t
running at startup, select All Programs > Startup from the Start menu, and see if Adobe Gamma
is on the list. If it is, right-click it and choose Delete from the popup menu.

Self-Calibrating
Beyond the simple decision between a CRT and LCD monitor, some CRT monitors also offer a
built-in calibration capability. A good example is the Sony Artisan line of CRT monitors. These
include a colorimeter for monitor calibration, but the benefits go beyond simply including calibration
tools in the box. Besides the normal connection to the computer that sends the video signal to
the monitor, a control connection is also included, usually connecting to a USB port. This allows
the computer—through calibration software—to control the monitor settings directly without
user intervention.

The result is an effortless calibration process. Instead of manipulating the monitor controls in the
first step of calibrating the display, all you need to do is confirm the desired target values, attach
the colorimeter, and click a button to begin the process. You can then walk away from the computer
while the monitor is calibrated and profiled. After about five minutes, the process is complete, and
you simply remove the colorimeter and close the software, confident that the display is now
accurate.

The monitors that support self-calibration are quite a bit more expensive than purchasing a different
monitor and a separate calibration package. However, the monitors that do include this feature
are also at the top end, providing the best image quality available. For those who demand the
utmost in image quality, and appreciate the convenience of automatic calibration, it may very well
be worth the added cost.

Special Concerns - There are some special issues to be concerned about with LCD monitors.
In general, they tend to be at higher risk of damage. The surface can be scratched if sharp objects
contact it, or damaged if it is touched too hard. In general, it is best to avoid touching the surface
of an LCD monitor. If young children will have access to your computer, an LCD monitor may not
be the best choice.

Another issue with LCD displays is that the manufacturing process can't always ensure that all
pixels will function properly. Some pixels may be "dead" (always black) or "hot" (always white) when
you buy the monitor, and the display will only be considered defective (and therefore due for
replacement under warranty) only if a set number of pixels are out when the monitor is new.

Making the Monitor Choice
Keep in mind that you really can’t make the best decision based solely on the specifications on
paper for a particular monitor. You really don’t know how good your images will look on the
monitor until you’ve seen the monitor for yourself. If at all possible, try to visit a store that sells a
wide range of monitors so you can be assured of optimal quality. If you do your research online
or through written reviews, make a list of the monitors that seem to best meet your needs, and
try to arrange to see as many of those in person before making your final decision.

Monitor Calibration
Regardless of the monitor you choose to purchase, calibrating the display is a critical aspect of
getting accurate output. The process actually involves two distinct steps: calibration and profiling.

The calibration step involves actually adjusting the behavior of the monitor to get the display as
close as possible to established standards, optimizing overall brightness and contrast and getting
the white point as neutral as possible. This requires that you adjust the monitor display using the
control buttons on the face of the monitor, determining optimal settings based on displays presented
in the calibration software, often with help from measurements by the colorimeter.

Once the monitor has been calibrated, a colorimeter is used to measure a series of color and
neutral values on the monitor. The measurements are compared to the known values that were
being displayed, and the variations between those values are used to build the monitor profile,
which effectively describes the color behavior of the monitor. This profile enables compensation
for that behavior to ensure an accurate display.

Because monitors do shift in both color and brightness values over time, it is important to re-
calibrate them on a regular basis. For CRT monitors, it is best to calibrate about every two weeks.
Because LCD monitors don’t drift as rapidly, you don’t need to calibrate them as frequently, but
doing so every month or so is still prudent.

Adobe Gamma
Adobe Gamma is a utility for monitor calibration included with the Windows version of most
Adobe software (including Adobe Photoshop). It is designed as a basic tool for adjusting your
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into many other devices, including external hard drives, digital media card readers, and digital
camera connections.

IEEE 1394 supports maximum data throughput rates of 400 megabits per second, or about 50 MB
per second. Another advantage of this specification is that devices can be connected in series (referred
to as “daisy chaining”) so that multiple devices can be attached using a single port. IEEE 1394 is hot-
swappable and supports plug-and-play, so that devices will be detected as soon as they are
connected.swappable and supports plug-and-play, so that devices will be detected as soon as they
are connected.

IEEE 1394b
IEEE 1394b (FireWire 800) is an update to the original IEEE 1394 specification, and offers data
throughput of up to 800 megabits per second, or about 100 MB per second. This provides a significant
benefit for external hard drives, providing speeds that rival what can be achieved with most
internal drives.

PC Card
The PC Card interface (formerly known as PCMCIA) is used primarily on laptop computers as a way
to provide support for a wide variety of peripherals. For digital imaging it would be used primarily
in conjunction with an adapter to directly connect digital media cards for download.

The PC Card specification has a maximum data throughput rate of 67 megabits per second, or about
8 MB per second, making it a relatively slow connection. For most photographers, this connection
should be considered a last resort for data transfer use.

CardBus
The CardBus interface is a 32-bit version of the PC Card interface. It offers data transfer rates of 1,056
megabits per second, or about 132 MB per second. While a variety of peripherals are available that
utilize a CardBus interface, the most noteworthy for digital imaging are the CardBus adapters for
downloading images from digital media cards.

PCI Express
PCI Express is actually an architecture for connections between expansion cards and the motherboard
in the computer. It extends the existing PCI architecture while maintaining backward compatibility for
existing PCI cards. The current version of PCI Express provides the potential of transferring data at
up to 16 GB per second. This will obviously provide exceptional performance for high-capacity storage
devices such as external hard drives. This will provide more than adequate bandwidth for existing
high-performance interfaces such as FireWire 800, USB 2.0, and Gigabit Ethernet. It will also help
ensure future technologies can take advantage of maximum throughput possibilities. PCI Express is
currently being utilized for display adapters and gigabit Ethernet adapters, but it could also be utilized
for other adapters in the future to provide higher throughput for storage devices and other applications,
so it is worth keeping an eye on.

Peripheral Interfaces
There are a variety of interfaces available for connecting external devices to a computer, each with
its own performance capabilities. For devices that benefit from maximum data throughput, such as
external hard drives and digital media card readers, you’ll want to ensure you have ports for a fast
interface that supports the devices you plan to use.

Keep in mind that the maximum data throughput speeds for these interfaces should be thought of
as theoretical maximum values. Actual performance will vary based on the specific device being used
and the computer’s capabilities, as well as the performance of the media for removable media drives
(such as digital media cards from digital cameras). For example, when using any of these interfaces
to download images from a CompactFlash card using an appropriate reader, the capabilities of the
CompactFlash card itself will greatly reduce the actual throughput rates you are able to achieve. That
doesn’t mean you should settle for a slower interface, as the fastest interface will still provide a benefit.
The benefit just isn’t as significant as the raw specifications for each interface would otherwise indicate
for certain applications.

USB 1.1
The Universal Serial Bus (USB) interface has developed into a ubiquitous technology found on virtually
all computers. The primary advantage of USB when it first became available was that it offered plug-
and-play support for a wide variety of devices. The USB 1.1 standard offers maximum data throughput
of 12 megabits per second, or 1.5 megabytes per second. As USB grew in popularity, the ubiquity
of this interface became another major advantage, and helped lead to a wide range of peripheral
devices that connected via USB. However, the relatively slow data throughput rate offered by USB
1.1 makes it inadequate for connections that will be used to carry significant amounts of data.

While expansion cards offering USB 2.0 support are available, if you have a computer that only offers
USB 1.1 support that is an indication you’re probably using an older computer that is due for
replacement to achieve optimal overall performance for digital imaging.

USB 2.0
The newer USB 2.0 standard offers considerably higher data throughput rates than the original USB
1.1 standard, while maintaining the benefit of plug-and-play support. It offers a theoretical maximum
throughput of 480 megabits per second, or 60 megabytes per second. Because of overhead in the
data transmission protocol, actual sustained throughput will be less than this, but still considerably
faster than USB 1.1, and adequate for transferring data at a comfortable rate.

Keep in mind that in order to achieve the maximum speeds available with USB 2.0, both the port on
the computer and the device being connected must support USB 2.0. If either are an older USB 1.1
device, it will function properly, but at the considerably slower speed of the USB 1.1 specification.

IEEE 1394
The IEEE 1394 (FireWire) interface was originally developed as a high-speed connection for moving
large amounts of data. It was originally most popular for digital video, but has since been incorporated
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Card Readers
While all digital cameras provide some form of interface to connect
the camera directly to the computer so you can download your
images, there are a variety of benefits to using a separate card reader
rather than such a connection. For one thing, it is safer to have the
camera stored in the camera bag, rather than sitting on top of your
desk with a cable connecting it to the computer, with an inherent
risk that you’ll accidentally pull the cable and send the camera
crashing to the floor.

Another benefit of using a card reader is the convenience of having
a simple device that offers a simple way to swap out multiple digital
media cards compared to the same process in a digital camera that
often has an access door and sometimes a release mechanism
designed to prevent accidental removal at a cost of a slightly more
complicated process of switching cards. This is certainly a relatively
minor issue, but improving convenience in your workflow includes
in improvement in efficiency.

When it comes to the issue of optimized performance, card readers
may offer an advantage depending on the specifications of your
particular digital camera model. Many digital cameras provide only
a USB 1.1 connection to the computer, while some of the latest
models (particularly professional models) offer FireWire 400
connections. While future cameras will likely support FireWire 800
for image download, you can still achieve a performance advantage
by using a card reader.

Interface Options
The choice of interface for a digital media card reader determines
the maximum rate at which you’ll be able to download images from
your digital media cards. However, for this application the maximum
theoretical speed of the interface can’t be achieved due to limitations
on the part of the digital media itself.

The slowest connection would be USB 1.1 or a PC Card slot on a
laptop. Each would provide throughput speeds of less than 1 MB
per second. Downloading the images from a 1 GB CompactFlash
card filled to capacity with one of these interfaces would require
about 15 minutes, which is painfully slow.

CardBus adapters for laptops offer faster throughput than a simple
PC Card slot adapter, achieving average speeds of around 4 MB per

second. This would result in a total download time of about 4 minutes for a 1 GB CompactFlash card
filled to capacity.

The fastest card readers presently available are the FireWire 400 devices, averaging around 5 MB per
second. Card readers utilizing a USB 2.0 connection aren’t far behind, averaging around 4 MB per
second. For each of these interfaces, downloading the images from a 1 GB CompactFlash card filled
to capacity would require about 3 or 4 minutes.

While the capabilities of the digital media you are using has a significant impact on the throughput
rates you can achieve for data transfers, it still makes sense to utilize the fastest connection possible
for a card reader. At present, the fastest option based on real world testing results is a card reader
utilizing a FireWire 400 interface. However, the maximum speeds for FireWire 400, USB 2.0, and
CardBus interfaces all exceed the maximum throughput of 16 MB per second for the CompactFlash
specification, so any of these will provide adequate overhead to achieve fast downloads.

Digital Media
Digital media is the “film” for today’s digital cameras, providing storage for the images as you capture
them. One of the advantages of digital photography is that the media used to record images offers
much greater capacity potential than the film it effectively replaces. For example, when using a
35 mm film camera you are able to capture a maximum of 36 exposures in one series using standard
film cartridges. With the largest CompactFlash cards currently offered with 12 GB capacity at this
writing, even with an 11-megapixel professional digital SLR capturing in RAW mode you can store
almost 1000 images. Even on a 1 GB CompactFlash card you would be able to store almost 90
images. Of course, recording all that data takes time, so performance issues need to be considered
when choosing digital media.

Performance Issues
The speed of your digital media determines both the maximum rate at which image data can be
written to the card by your digital camera and the rate at which those images can be downloaded
to your computer. The media itself tends to be the biggest bottleneck, and the difference between
the slowest and fastest media can be significant.

Most manufacturers of digital media have adopted the same system for indicating performance as
CD-ROM drives, where an “X” value is provided. A value of 1X is equivalent to 150 KB per second.
Unfortunately, no standard has been developed for how this performance specification should be
developed, and manufacturers don’t indicate what device could be expected to achieve the expressed
transfer speeds, and whether those speeds can be achieved for both read and write operations. In
most cases, actual testing indicates the actual performance of these cards does not match the “X”
value indicated for the card.

However, these performance indicators do tend to be a good indicator of relative performance. A
card with a 40X specification can be expected to perform faster than a 12X card. However, the
difference is not necessarily as significant as the numbers would indicate.
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System Configuration Summary
To give you a better idea of the basic specifications for computer systems at various levels, the
following are offered as guidelines. These include the basic specifications to establish the overall
system specs, with additional options being based on your preferences taking into considerations
the recommendations provided throughout this document.

A variety of sources are available for real world performance values for many CompactFlash cards.
Two such sources are the CF Database at www.robgalbraith.com and the Digital Film Comparison
at www.dpreview.com. Both indicate data transfer speeds that were actually achieved with a variety
of CompactFlash cards, and provide a better indication of the type of transfer speeds you can expect.

For most photographers the speed at which images can be downloaded (the “read” speed) is more
important than the speed at which images can be written to the card (the “write” speed). This is
because most photographers under most photographic situations won’t exceed the buffer within the
camera. As long as you don’t fill the buffer on the camera, the speed of your digital media card won’t
create a bottleneck, as the card is being written to as the camera is still recording to its internal
memory. However, as soon as that internal memory is filled, it must be flushed to the digital media
card. This can take a significant amount of time, and no pictures can be taken until the process is
complete. If you tend to capture a large number of images in rapid sequence, purchasing digital
media cards with the fastest write times can help minimize the risk of missing an important shot.

Because digital media performance can affect both capture capability and the time required to
download your images, purchasing the fastest cards possible will help ensure maximum efficiency
in your workflow.

Hardware Performance
Your choice of hardware components determines the performance capabilities of your computer,
which is a major factor in overall performance for digital imaging. An optimized configuration for
digital imaging revolves around the computer hardware you are using to process a large volume of
data while performing advanced software tasks. When purchasing a new computer or upgrading an
existing computer, give careful thought to the individual components to be included to ensure the
very best performance possible.

When making decisions about hardware specifications, you’ll often need to take your budget into
consideration, which means making compromises in terms of system specifications. When you need
to compromise due to budget considerations, consider maximizing specifications in the following
order, from most important to least important:

1. Amount of RAM
2. Processor Speed
3. Hard Drive Performance
4. Video Performance

Software Configuration
While hardware provides the pure processing power for digital imaging applications, software
configurations can have a significant effect on overall system performance. Optimizing your software
configuration both at the operating system and application level can pay significant dividends in
improved performance.

Windows XP
Windows XP provides significant performance enhancements over previous versions, making it an
ideal operating system for digital imaging. Windows XP is particularly stable, and does a great job
of maintaining overall system stability when a third-party application causes a problem. In particular,
Windows XP Professional is recommended for use in digital imaging applications, particularly in
environments where networking will be put to use to connect multiple users in a digital workflow.
Another advantage to working with Windows XP is the wide range of applications available for this
platform that can’t be found with other platforms.
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Imaging Basic

Processor

Memory

Hard Drive

Intel Pentium 4 3.0 GHz or
AMD Athlon 64 2.0 GHz

1 GB DDR SDRAM

250 GB SATA

Mid-Range

Processor

Memory

Hard Drive

Intel Pentium 4 3.6 GHz or
AMD Athlon 64 2.4 GHz

2 GB DDR SDRAM

400 GB SATA

Cutting-Edge

Processor

Memory

Hard Drive

Dual Intel Xeon 3.4 GHz,
Dual AMD Opteron 1.4 GHz or
AMD Athlon 64 FX 2.4 GHz

4 GB DDR SDRAM

Dual 400 GB SATA in
RAID-0 configuration
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Programs Launching at Startup
Many programs that run immediately upon starting up your computer provide convenient features
that can be a benefit to your overall workflow. However, these programs do consume a certain
amount of memory, and can also consume processing power, so it is best to limit these programs
to those that are essential or provide enough benefit to be worth a potential reduction in performance.

You can often tell when a large number of applications are running at startup by the icons displayed
in the Tray next to the clock on the Taskbar. In many cases, you can double-click on the icons here,
or right-click and choose an appropriate option, so that you can adjust the settings and disable the
program from running at startup. Otherwise, you’ll have to manually remove the programs you
don’t need.

The first place to look when manually preventing programs from running at startup is the appropriately
named Startup group on the Programs menu. From the Start button, select All Programs and then
Startup. Look at the programs on the Startup menu to see if they are actually necessary. If any
programs are included in this group that you are sure you don’t need, right-click on the icon for each
of those programs and choose Delete. This will remove the shortcut from the Startup group, preventing
the program from running when Windows starts.

Many programs create an entry in the system registry, allowing them to run at startup without
appearing in the Startup group. Removing registry entries to prevent programs from running when
Windows starts can be handled through the System Configuration Utility with minimal effort.

To access the System Configuration Utility, select Start > Run, type MSCONFIG, and then click OK.
Click the Startup tab and you will see a list of programs that get launched at startup. The Startup Item
column provides the name of the program, although the name shown can often be somewhat cryptic.
The full path to the program being run is shown in the Command column. For those familiar with
the System Registry, the Location column shows where in the registry the program is being run from,
or if the program is being run from the Startup group on the Start menu. You can disable programs
by clearing the check box to the left of the name. The great thing is that if you restart and discover
you’ve removed something you need, you can always re-enable it because you haven’t permanently
removed it.

Once you’ve disabled programs that aren’t
needed, click the OK button and restart
Windows. At startup you’ll receive a message
indicating you are starting the computer in
Selective Startup mode, which you can disable
if you prefer.

Regardless of how the program is being
launched at startup, it is important that you
know exactly what the program is before you
permanently prevent it from launching.
However, removing unnecessary programs

can speed up the process of loading Windows, and ensure that
background processing by these programs cause a reduction
in overall system performance.

Performance Options
There are a variety of options available to you in Windows XP
that allow you to adjust performance settings. A number of
these settings can be accessed by selecting Control Panel from
the Start menu and double-clicking the System applet. In the
System Properties dialog box that is displayed, select the
Advanced tab, and then click the Settings button in the
Performance section. This will bring up the Performance Options
dialog box, which is split between the Visual Effects and
Advanced tabs.

The Visual Effects tab allows you to control special effects that are used within the Windows interface.
While many of these won’t affect typical actions performed within your digital imaging workflow,
disabling many of the special effects can improve overall interface performance. To maximize
performance, select the “Adjust for best performance” option button, which will turn off all of the
visual effects check boxes. If there are particular visual effects you prefer to keep enabled, you can
simply click the check box for those options.

The Advanced tab provides controls that affect how Windows handles processor scheduling and
memory usage, as well as the virtual memory settings. These settings will affect overall system
performance by determining how the operating system will allocate various hardware resources.

The Processor Scheduling section allows you to specify whether you want Windows to provide the
greater share of processor performance to programs running in the foreground (the applications
you’re actually using) or background services. Select the Programs option to ensure optimal performance
for the applications you are utilizing in your digital
imaging work.

The Memory Usage section determines whether memory will
be allocated to optimize performance of either applications
or the system cache. Since application performance has a
greater impact on overall speed in your workflow, select Programs.

The Virtual Memory section controls the size of the paging
file used by Windows to simulate additional RAM when other
applications (or the operating system itself) have made use of
all available memory. Hard drive performance considerably
slower than RAM, so overall system speed will slow when virtual
memory usage is necessary, but making use of hard drive space
in this capacity
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prevents problems that would otherwise occur if the system were permitted to get critically low on
available RAM.

To adjust the Virtual Memory settings, click the Change button in the Virtual Memory section of the
Advanced tab on the Performance Options dialog box. This will bring up the Virtual Memory dialog
box where you can adjust the paging file settings that handle the virtual memory functionality.

The list box at the top of this dialog box allows you to choose the drive you’d like to adjust settings
for. If you have multiple drives in your system, you can adjust the settings for each drive individually
by selecting each drive in turn and changing the settings for that drive. Ideally, you should put the
paging file on a high-speed hard drive with adequate capacity, preferably a drive other than the one
system files are installed on. If you have several drives to choose from, select the drive with the fastest
performance, and make sure there is more than adequate space available on this drive, moving data
to other drives if necessary to provide adequate capacity for a large enough paging file.

You can leave the paging file option for available drives set to “System managed size” and Windows
will automatically determine an appropriate size. The minimum size will be 1.5 times the amount of
RAM installed on your computer, with the maximum recommended size at three times that value. If
you are going to manually adjust settings, be sure to set it higher than the minimum recommended
value, and preferably much larger. In general, you should provide at least as much as the maximum
recommended value.

If you have multiple drives available for the paging file, set the paging file settings so that each drive
can be used, maximizing efficiency. However, do not spread the paging file across multiple partitions
of the same physical hard drive. It is also recommended that you not place the paging file on a fault-
tolerant drive such as one configured with mirroring or RAID-5, as this can cause
performance problems.

While it would never be a good idea to set all drives to “No paging file”, if you have multiple hard
drives you may want to disable the paging file for the drive system files are installed on, and then
set a large paging file size for the other drive or drives.

To apply the settings you’ve established for a given drive, click the
Set button. When you are finished configuring Virtual Memory click
OK to return to the previous dialog box.

Display Settings
When it comes to the display settings used for your monitor, there
is a need to consider image quality and color fidelity in addition to
overall system performance. When image quality is of the utmost
concern, you’ll want to maximize display settings even if it means
you aren’t quite getting optimal performance from your system.
The quality benefit far exceeds any minor performance penalty for
an otherwise powerful computer system.

Driver Updates
Display adapters are highly complicated devices, and the drivers that control them play a critical role
in the overall mission of the computer system. If there is a problem with the display drivers, it can
affect system stability and performance. It is highly recommended that you periodically check the
manufacturer’s Web site for your display adapter, and install any updates as they become available.

Resolution
Display resolution is another area where you must define what performance means, or compromise
on optimal performance to achieve the benefit of higher resolution. For some, optimal performance
would be defined as having maximum information on the monitor at once, so you can see as many
pixels in your image as possible. For others, it is all about ensuring the display can be updated as
quickly as possible. With an advanced display adapter, speed shouldn’t be an issue, so you can focus
on setting a resolution that maximizes the amount of information you’re able to see on the monitor.

You can adjust the display resolution by accessing the Display Properties dialog box. This can be
accessed from Start > Control Panel > Display, or by right-clicking an empty area of the desktop and
selecting Properties from the popup menu. In the Display Properties dialog box, select the Settings
tab. If you have multiple monitors active on the system, you can select each of them in turn by clicking
them in the preview area or by selecting the monitor you wish to adjust from the Display
drop-down list.

The display resolution can then be adjusted using the Screen Resolution slider. The optimal value will
depend largely on personal preference. The only downside to using an extremely high resolution is
that interface elements and text will appear quite small on the monitor, possibly making it difficult
to use such a setting comfortably. Since there is an advantage to having as much information displayed
at once as possible, I recommend setting the highest resolution setting supported by your display
adapter and monitor combination (though for LCD monitors you may want to simply use the optimal
resolution instead). If the setting is too difficult on your eyes, reduce the resolution setting to find
one that balances your needs.

Provided you’re using a display adapter that has excellent performance, you shouldn’t experience
any problems with using the highest resolution setting available.

Color Quality
The Color Quality setting on the Settings tab of the Display Properties dialog box allows you to
determine the bit-depth of the color display for your monitor, which translates into the total number
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of colors the display is able to produce. As you can imagine, this is an area where color fidelity is
probably more important than display performance. However, once again, if you are using an
appropriate display adapter you shouldn’t experience any performance problems when using the
highest available setting. I recommend setting the Color Quality to the highest value available to
maximize the range of colors your display will be capable of.

Display Effects
The Appearance tab allows you to adjust the color scheme for windows
and dialog boxes within the Windows interface, but it also allows you to
establish settings for special effects related to interface elements. While these
settings won’t have a significant impact on performance of primary digital
imaging tasks, it can affect perceived performance of the overall interface.

Each of the settings available is offered as a check box for a particular display
effect. You’ll achieve faster interface element performance (such as the time
required for menus to display) by turning all of the check boxes off. These
aren’t critical performance issues to consider, and many users enjoy having
these display effects active, but you may want to try turning them off to
see if you like the “snappier” response you’ll get from some interface elements.

Advanced Settings
By clicking the Advanced button on the Settings tab of the Display Properties
dialog box you can adjust additional settings for your display.

If you are using a particularly high resolution setting, and want to make the text larger, the General
tab provides a DPI Setting in the Display section. The default is 96 dpi, with the 120 dpi setting
providing larger text. You can also set a Custom Setting if preferred to fine-tune the size of text on
your display.

The Monitor tab includes a setting for the Screen Refresh Rate, which determines how frequently the
monitor display will be updated. For CRT monitors you want to use a setting above 85 Hertz to ensure
a flicker-free display. Higher settings provide assurance that the display will update as frequently as
possible and won’t have any flicker. Such flicker may not be readily apparent at lower refresh rates,
but can still cause eyestrain.

While the highest Screen Refresh Rate available may be the best choice for a CRT monitor, if you’re
using an LCD display you’ll want to check the specifications before setting a high refresh rate. The
display on an LCD will generally not benefit from a higher refresh rate (flicker isn’t an issue with LCD
displays), and using a rate that is too high may damage the monitor.

Confirming Proper Profile
While you can generally trust most monitor calibration tools to provide to properly configure the
monitor profile, it is a good practice to confirm the profile has been properly set as the default display
profile after calibrating. The Advanced settings for the Display Properties also includes a way for you

to confirm that the proper monitor profile is being used for your
display. On the Color Management tab the Current Monitor (based
on the monitor that was active when you clicked the Advanced
button on the Display Properties dialog box) will be listed, and
the Default Monitor Profile currently in use will be shown. If this
is not the same as the profile you saved when you most recently
calibrated your monitor, you’ll want to change it accordingly.

If the correct profile is listed in the list box in the bottom half of
the dialog box, you can simply click that profile and then click the
Set As Default button. If it isn’t included on the list, you can click
the Add button and select the appropriate profile from the Add
Profile Association dialog box that will be displayed. Then you’ll
be able to select that profile from the list and click the Set As Default button. The correct profile will
then be listed as the Default Monitor Profile.

Keep in mind that if you are using a single display adapter with multiple monitors support you’ll only
be able to use one profile for both monitors. That means the second monitor may not be as accurate
as your primary monitor. You can adjust the monitor controls on the second monitor to get it as close
as possible, but critical color and tonal evaluations should always be performed on the primary
monitor that has been calibrated.

Adobe Photoshop
Adobe Photoshop has a well-earned reputation as the
most powerful digital imaging software available. It provides
the user with extraordinary power for creating, optimizing,
and manipulating images, to the extent that you are really
only limited by your imagination. All that power—especially
when working with high resolution images—naturally
requires considerable computing power. Besides making
sure your hardware and operating system are configured
for optimal performance, there are also settings in Adobe
Photoshop that are important to achieve the fastest processing of your digital images.

Preferences
The Preferences dialog box in Adobe Photoshop allows you to adjust a wide variety of settings related
to various features. Many of these settings, as the name of the dialog box implies, are determined
by personal preference. However, certain settings can have a significant impact on performance. The
Preferences dialog box can be accessed from Edit > Preferences on the menu.

History States
The History States option is found on the General page of the Preferences dialog box. This setting
determines how many individual steps performed (history states) Adobe Photoshop is able to
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remember when you’re working on an image. Since the History palette maintains a list of those history
states, allowing you to select a previous point in time to revert to (effectively undoing any tasks
performed after that step), you may be tempted to set a very high value for History States. However,
each of those individual states requires memory to store, and having too many history states can
consume considerable memory, leaving less for Adobe Photoshop to use for the power-hungry tasks
you need to perform.

It is therefore best to set the History States setting to the smallest number you are comfortable with
in order to preserve memory for use by Adobe Photoshop. This requires a balance between your
comfort level with the chance of making a mistake you’ll want to undo and optimizing performance.
The maximum value is 1000 history states, and you can well imagine how much RAM would be
consumed if you actually performed 1000 steps on a high resolution and Adobe Photoshop had to

store in memory the results of each of those changes so it could revert
to any one point in time at your choosing.

While we never plan to make a mistake, it is very helpful to be able to
undo a series of steps when you discover you’ve done something you
wish you hadn’t. Therefore, the setting you use for History States will
always represent a compromise between comfort level and RAM usage.
A setting of 20 is usually more than adequate provided you monitor
the changes you make to your images as you work. To be safer, you
might want to start with a higher setting of between 40 and 50, and
then keep tabs on how far back on the History palette you need to
go to undo mistakes over the course of a few weeks of working on
images. That will give you a better idea of how low you can comfortably
lower the setting to.

Export Clipboard
The Export Clipboard setting is a check box found in the Options section of the General page of the
Preferences dialog box. This setting determines whether data copied to the clipboard in Adobe
Photoshop will be available in other applications. The clipboard feature is a great way to copy data
from one application and paste it into another application. However, when you copy data in Adobe
Photoshop, that generally means pixels, and it could be a large number of pixels. The process of
converting the pixel data to the format required to make it available to outside applications can take
considerable time, especially when you’ve copied a large number of pixels, and it consumes RAM
as well. It is best to keep this option turned off until you are in a situation where it is needed.

Cache Levels
The Cache Levels setting is one that represents a fine line between RAM usage and overall system
performance. Consuming more RAM can obviously reduce overall system performance (especially
if you run out of available RAM), but the capability controlled by the Cache Levels setting is actually
designed to use a modest amount of RAM in order to improve performance when it comes to
redrawing a large image on the screen at different zoom settings.

The Cache Levels setting actually determines how many scaled versions of your image will be stored
in memory so they can be recalled very quickly when you change the zoom percentage. If the size
that needs to be displayed isn’t stored in the cache, the image must be redrawn at that size, which
obviously requires a bit of time. This is an issue that affects relatively large image files in particular.

The main question is whether the RAM used by this feature is worth the performance gained for
screen refresh. This depends on your particular situation. If you work with particularly large image
files, yet have more than adequate RAM, you may see a performance improvement by setting the
Cache Levels setting to a higher value. If, on the other hand, you’re running low on RAM, setting the
Cache Levels to the minimum setting will reduce the amount of RAM consumed.

The minimum setting for Cache Levels is 1, and the maximum is 8. The value indicates which of the
display sizes will be stored in cache for fast access, in order from largest to smallest preview size. The
preview sizes that can be stored in cache are: 66.7%, 50%, 33.3%, 25%, 16.7%, 12.5%, 8.33%,
and 6.25%.

Having more of these previews available in cache is of particular help when working on very large
files, in part because storing the images in cache prevent the need to create the resized on-screen
image on the fly from these larger images and in part because with larger files like this you’re more
likely to use the smaller display percentages so you can see larger portions of the image at a given
time. Of course, when working with particularly large images, even the smaller preview images stored
in cache can be quite large, so this most certainly represents a balancing act.

In short, if you’ve configured your system with more than adequate RAM, you will probably benefit
from having the Cache Levels setting set to the maximum value of 8. If you don’t have adequate
RAM, you may want to use a lower setting, but you’d achieve greater performance by upgrading the
amount of RAM in your computer to ensure you have enough.

Scratch Disk Setup
When working with high resolution images with multiple layers, before you know it the size of the
image data may exceed even the maximum 2 GB of RAM Adobe Photoshop is able to address. When
that happens Adobe Photoshop will use hard drive space to supplement RAM. In fact, Adobe
Photoshop CS is able to create up to 64 exabytes (1.074 billion gigabytes) on up to four hard drive
partitions. Of course, this is a theoretical maximum at this point, since hard drive capacities haven’t
gotten anywhere near such levels. In other words, the scratch disk space is only limited to the amount
of free space available on the hard drives installed in your computer.

The scratch disk settings are found on the Plug-Ins & Scratch Disks pages of the Preferences dialog
box. In the Scratch Disks section are four drop-down lists for selecting a drive to use as each of four
scratch disks. They will be used in order from first to fourth. As space is exhausted on the first, Adobe
Photoshop will start using each of the next drives on the list. Of course, setting multiple Scratch Disks
requires that you have multiple hard drives installed.
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If you have multiple hard drives available, the setting for which order those drives will be used for
scratch disk purposes can have an effect on performance in Adobe Photoshop when the scratch disk
needs to be accessed.

One of the key issues is to avoid using the same drive the operating system is installed on (and
therefore possibly using for virtual memory) for the primary scratch disk drive. Instead, set the First
scratch disk option to a separate physical drive with high performance and adequate free space. Then
set the Second through Fourth options in order of priority for the available drives in your system.

The priority for these settings should be based on optimal
available performance when Adobe Photoshop needs
to access the drive for scratch disk purposes. The priority
should be given in the following general order:

1. High-performance drive with adequate space that
isn’t being used for virtual memory by Windows 
XP and isn’t used for image storage.

2. High-performance drive with adequate space that
isn’t being used for virtual memory by 
Windows XP but is being used for image storage.

3. High-performance drive with adequate space that is also being used for virtual memory by
Windows XP.

4. High-performance external hard drive connected via FireWire 800 with adequate space.

5. Drive Windows XP system files are installed on, which may also be used for virtual memory.

6. External drives with connected to a less-than optimal interface
(anything slower than FireWire 800)

Keep in mind that the list of available drives in the Scratch Disks section will include all drive letters
on your system, even if some of those drive letters represent individual partitions on a single physical
hard drive. All partitions on a single drive should be considered the same drive, because you won’t
get a performance advantage by using them at the same time, and could in fact have a significant
performance hit by trying to access two partitions on the same drive at the same time. You should
therefore only use a single partition for scratch disk space on a given physical drive.

Since Scratch Disk usage can consume considerable space on your hard drive, it is strongly recommended
that you maintain a large amount of available space on the drive (or drives) being used for Scratch
Disk usage. As a general rule, you should maintain free space for Scratch Disk usage that is at least
five times greater than the largest file size (based on actual file size, not just the pixel-dimension size)
you expect to work with.

Considering the potential demands placed on a drive used for Scratch Disk space, you can achieve
a performance advantage by installing an additional high-performance hard drive for the exclusive
use of Adobe Photoshop for a Scratch Disk.

Memory Usage
When Adobe Photoshop is launched, it reserves memory
for its use. The amount it reserves is based on the setting
in the Memory Usage section of the Memory & Image
Cache page in the Preferences dialog box. Obviously
setting a value that is too low will limit the amount of RAM
Adobe Photoshop is able to utilize, which can lead to
performance problems and even crashes. However, setting
the value too high can also lead to problems.

Adobe Photoshop is only able to address the first 2 GB
of RAM on the computer. If you have less than 2 GB of RAM, you may want to limit the setting to
about 50% to avoid potential performance problems. If you have 4 GB of RAM or more, set the value
to 70%, which will ensure Adobe Photoshop will have access to as much as possible of the 2 GB
maximum it is able to address.

File Browser Preferences
The File Browser Preferences settings can be accessed
from the File Browser page of the Preferences dialog box,
or by selecting Edit > Preferences from the menu within
the File Browser. The settings available for the File Browser
can have an impact on overall system performance,
particularly when browsing for images for sorting or looking
for the one you want to work on. Many of the settings
are simply about personal preference, but others will have
an effect on system performance within Adobe Photoshop.

The “Do Not Process Files Larger than:” option controls which files will actually have thumbnails and
previews generated. Obviously you would probably like to see thumbnails and previews for all of your
images, but processing large files for these previews can require a considerable amount of processing,
which will slow down overall performance when using File Browser. If you’d rather wait patiently for
the previews to be generated for even your largest files, you can set this value high enough to include
all images. The default setting will cause files larger than 200 MB to be ignored. For most situations

this will include the majority of images, but for those working with multi-layered composite images,
or images from higher resolution sources (such as medium format photography), a considerable
number of files may exceed this limit. This is largely a matter of balancing the need to preview images
over the performance for the majority of images. Try setting the value high enough that it will include
the vast majority of your images, excluding only the images that are an exception to the normal file
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space is generally considered best for images that will be printed. The sRGB option is more than
adequate for images that will be displayed via monitor or digital projector, or that will only be printed
on inkjet printers. For CMYK the profile used for images will depend upon the specific output process
to be used. Therefore, it is often not possible to establish a single working space for CMYK images.
Instead, set the CMYK working space to that which applies to the output process for which you are
currently preparing images. In other words, if you work with CMYK images on a regular basis, you
may well be changing this setting regularly. Another option is to set the CMYK working space to the
profile used most often, using the Convert to Profile option for any exceptions.

The Gray and Spot working spaces tend to be used infrequently by most users, but a good default
for this is Dot Gain 20% if you are preparing images for print and Gamma 2.2 if you are preparing
images for monitor or digital projector display.

The Color Management Policies section determines what action will be taken when you open an
image that does not use the current default working space for its color mode. Using the Off setting
will effectively turn off color management, which isn’t something you want to do. Instead, you have
the choice of Convert to Working or Preserve Embedded Profile. The
Convert to Working will cause the image to be converted to the working
space established in the Color Settings dialog box for the color space
of the image being opened. When you save the file again, the working
space will be set as the embedded profile for the image.

The Preserve Embedded Profile option will cause the image to be left
in the embedded color space. When the file is saved, the embedded
profile will remain as it was when the file was opened. The Preserve
Embedded Profile option can be helpful for viewing an image based
on what it was intended to look like, such as when film is scanned using
a custom profile.

Choosing between these two options is largely a matter of where your
files come from and how you prefer to work. If you are working with
film scans or digital captures you’ve produced yourself, you can
comfortably convert your images to the working space. If the files are
coming from a different source with a custom profile embedded, you
should probably preserve the embedded profile to see what the image
was intended to look like, after which you can convert the image to
your working color space if preferred.

The check boxes found in the Color Management Policies section
determine whether Adobe Photoshop will ask for confirmation about
the action to be taken when an image is opened that has an embedded
profile other than the working space. If the check boxes aren’t checked,
Adobe Photoshop will perform the action you have designated in this
section of the dialog box when an image is opened. If the check boxes

sizes you work with. If, on the other hand, most of your files are very large, you’ll need to determine
what is more important: performance building previews for smaller images or including previews for
all images.

The Custom Thumbnail Size option determines how large the image thumbnails will be when you
select Custom rather than one of the preset size options. A larger size allows you to view more detail
in the thumbnails, which can be especially helpful when working at higher display resolutions, but
obviously these larger previews will require more time to render. In most cases one of the preset
values will work well, but you can set a custom size if preferred. If you are going to use a custom
thumbnail size, try to balance the ability to see a larger image with the time required to build
those thumbnails.

The Allow Background Processing check box determines whether Adobe Photoshop will work on
pre-processing previews and metadata when you’re busy with other tasks. In general this option
should be turned off to improve overall performance.

The High Quality Previews provides an option for the quality level of the previews that will be generated
for your images. While higher quality is certainly a good thing, those previews do require more time
to generate and more disk space to store. In general it is best to keep this option turned on, but if
you want to minimize the amount of time and disk space required it can be turned off.

Color Management Settings
The color management settings in Adobe Photoshop don’t directly relate to optimal performance,
but they can certainly have an effect on the accuracy (and therefore efficiency) of your digital imaging
workflow. While the best settings will depend upon your particular situation, understanding what the
various settings mean will allow you to choose those best suited to your needs. The Color Settings
dialog box is accessed by selecting Edit > Color Settings from the menu.

The Advanced Mode check box provides a wider range of options for the Working Spaces section,
and also includes additional controls in the dialog box. For most users there is no need to have the
Advanced Mode check box checked.

The Working Spaces section determines the default color space
that will be used for your images for the various color modes
available. This is the color space that will be used when you convert
images simply by changing the color mode (rather than converting
to a specific profile), and you can also have images converted to
this working space (if applicable) when they are opened.

Most of the time in a typical digital imaging workflow you would
be working with RGB images, so this is the most important color
space to consider. While opinions vary, the Adobe RGB (1998) color

Creating an Optimized Windows XP
Digital Imaging System



3938

are checked, Adobe Photoshop will ask you what action should be taken, but the default will be the
setting you established in the Color Settings dialog box.

The Conversion Options and Advanced Controls sections of the Color Settings dialog box are only
displayed if you have the Advanced Mode check box checked. For most users there is no need to
make use of these sections, so the Advanced Mode check box can simply remain unchecked.

Workspace Setup
Another factor that can affect the efficiency of your digital
imaging workflow is the palette setup within Adobe
Photoshop. You can maintain a clutter-free desktop
environment within Adobe Photoshop by only displaying
the palettes you actually use. You can also improve the
efficiency of your workflow by arranging the palettes in a way that makes sense to you and enables
you to work more quickly.

If you are working with multiple monitors, you can maximize your efficiency by moving the palettes
to the second monitor, leaving the primary monitor for the exclusive use of the image you’re currently
working on.

To help ensure you never lose your palette setup, you can save the workspace, which saves both
palette locations and the File Browser layout. Once you have arranged the palettes as desired, you
can save the settings by selecting Window > Workspace > Save Workspace from the menu. Provide
a name that describes the working space so you’ll know what it is, and click Save. You can then
activate any saved workspace by selecting Window > Workspace and then the name of the saved
workspace from the menu.

If you share your computer with others, or if you find you prefer different palette arrangements for
different types of work, you can save more than one workspace configuration. Even if you only have
one palette layout you utilize, it is a good idea to save it just in case your palettes get rearranged
and you want to reset them to the original layout.

Maintenance
Configuring your system properly in the first place is certainly a
critical step in optimizing your digital imaging workflow. However,
you’ll also want to perform routine maintenance to confirm your
system continues to offer peak performance.

Disk Defragmenting
When files are written to a hard drive, they aren’t written as a single
block of data. Rather, the files are broken into clusters of data, the
size of which is determined by the hard drive settings and the way

it was partitioned and formatted. If a large enough contiguous section of the drive is available, all
of the clusters may be written as one block. However, if files have been added and removed from
the drive (which obviously occurs with normal use) the available space may be broken into a number
of discontiguous clusters. As a result, files written to the drive
may be spread across a number of widely scattered clusters.
When these files are read in the future, they must be read
from those scattered clusters, which increases the amount
of time required to open the files.

Periodically running the Disk Defragmenter will reorganize
the files on the hard drive to put clusters in order, so that
each file (to the extend possible) has all of its clusters in a
single group, speeding up the process of reading the files.
You can run the Disk Defragmenter utility from Start > All
Programs > Accessories > System Tools > Disk Defragmenter.
This will launch the utility, where you can select a drive you want to work with and then click Analyze
if you want to see how fragmented the disk is and Defragment if you want to run the utility on the
selected drive.

Since the process of defragmenting your hard drive can take some time, particularly with a high-
capacity hard drive, it is recommended that you start the process when you know you’ll have plenty
of time for it to run. For example, you can start it up at night when you’re done working for the day,
or at the end of the week before heading out for the weekend. Once completed, the files on your
hard drive will be organized and overall performance will improve.

Error Checking
A hard drive failure can cause a significant loss of important data, but periodically checking your hard
drives for errors can catch problems before the become a serious issue. The Error Checking utility
can be accessed by right-clicking a hard drive in My Computer or Windows Explorer and choosing
Properties from the popup menu. Then select the Tools tab and click the Check Now button to bring
up the Check Disk dialog box. It is recommended that you check the “Automatically fix” check box
so any problems discovered will be corrected automatically.

Besides running a standard check to locate and fix common
problems, you can also have this utility check for physically
bad sectors on the drive. If any are found, they will be marked
as such so they won’t be used for storing files. This process
can take a considerable amount of time, so it is best saved
for a time when you don’t need your computer for an
extended period. However, it should be run periodically to
confirm your hard drive remains healthy. Once bad sectors
start to appear, it is usually the indication of a more significant
problem, and planning to promptly replace the drive when
that occurs would be prudent.
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Backing Up
No matter how careful you are with your data, losing files from accidental erasure or system failure
can occur. It is critical that you protect yourself (and your files) by performing regular backups. As
file sizes and total capacity requirements have increased exponentially, backup options have become
more of an issue. While you can use virtually any media to backup your critical files, for convenience
and performance it is difficult to beat the use of external hard drives. You can backup your files either
by simply copying them manually or by using software that either automatically in real-time or on
a preset schedule backs up files in folders you have designated.

When planning a backup system, consider storage capacity, reliability, and accessibility as primary
concerns. You want to be sure your backup system will have the capacity to store a large number
of image files so you don’t need to limit how many files can be backed up at once or on a single
media cartridge or disc. You also want to be sure the media used is reliable enough that you can
be confident it will be readable when you need it. For example, CD-RW media is not considered
archival and would not be a good choice, while external hard drives have proven very reliable. It is
also convenient to have a backup system where the files are easily recoverable in the event of data
loss. Ideally, you want to be able to access a drive or media that has the files in their native format,
rather than needing to extract files from a backup in a proprietary format.

Whatever system you use, it is critical to perform regular backups of your critical files to ensure you’ll
be able to recover from a system failure. It is also a good idea to store the backup copy at a separate
location to help ensure you’ll be able to recover from even the worst situations resulting in data loss.

Conclusion
Digital imaging requires a considerable amount or processing power in your computer. While it is
relatively easy to figure out what type of computer specifications will provide high performance,
configuring a system with appropriate settings within the operating system and applications being
used can be more of a challenge. This document has provided you with information to help you
better understand the various hardware specifications, Windows XP configuration, and software
settings that can help you achieve optimal performance for your digital imaging applications.

Additional Information
For more information about the topics discussed in this document,
visit www.microsoft.com/digitalphotography/
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Besides writing, Tim also lectures and teaches courses on digital imaging. With such a busy schedule,

he doesn't get much time to actually take pictures. When time allows, he enjoys photographing birds,

flowers, and just about anything else that catches his eye near his home on California's central coast.
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